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1 Description

This device is a fully digital stereo encoder with preemphasis limiter and optional RDS encoder.

1.1 Listofchanges

1.1.0 17/06/2014 first release

2.0.0 23/09/2014 updated to new firmware 2.0 features
2.0.1 20/11/2014 updated to new firmware 2.1 features
3.0.0 10/03/2015 updated to new firmware 3.0 features
3.1.0 18/12/2015 MPX coder version only features added
3.1.0 25/01/2016 updated to new firmware 3.1 features
3.2.0 14/09/2016 updated to new firmware 3.2 features
3.2.1 08/03/2021 updated to new firmware 3.2.1 features

1.2 Warnings

Before attempting any operation, please follow the safety instructions contained in the
following paragraph.

The producer declines any liability for damage to people or things due to non-compliance,
even if partial, of the following indications

« Ensure that the supply wltage corresponds to what is indicated on the apparatus.
« Ensure that the electrical system is equipped with a ground connection.

« Use only power sockets and cables with ground connection

 Disconnect power before attempting any operation inside the device.

» The power cutting device is the power cord, so this should be easily accessible and the socket
must be positioned close to the apparatus.

< Any operation invohving the access to internal parts must be performed only by trained senice
personnel.
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1.3

1.4

Front panel

Front panel indicators and rotary knob

RDS: RDS is actiwe, if the led blinking the "AudioMuteRDS" function is actiwe,
see paragraph Pl PTY

CLIP: The analog input level is too high.

DIG IN: AES/EBU digital input is selected as audio source

NET: Network audio is selected as audio source(option).

Menus navigation and parameter editing is done through the rotary knob.

Rear panel

VA

o lEeA | o o o
B> eee

° o

SCAIN RS232 USBDRIVE _LAN

(=]
DIGIN LEFTIN RIGHTIN 19K OUT/

Connectors on rear panel

DIG OUT (XLR M)
DIG IN (XLR F)
LEFT IN (XLR F)
RIGHT IN (XLR F)

19K OUT/MPXIN (BNC F)

MPX OUT (BNC F)
SCA IN (BNC F)

LEFT OUT (XLR M)
RIGHT OUT (XLR M)
RS232 (DSUB 9F)
USB DRIVE (USB-A)

LAN (RJ45)

AES/EBU output (option)

AES/EBU input

Left analog input

Right analog input

19KHz output for external RDS encoder synchronization. (1Vpp
trapezoidal wave) or MP X input for audio changeover (option)

Composite MPX output (+6/-6dBm)

External SCA / RDS input (will be mixed to MPX output with a gain of
-20dB)

Left channel analog output (option)

Right channel analog output (option)

RS232 connector

USB connector for fallback audio on external drive (available on Ip
Audio Stream option)

LAN connector for remote control or streaming audio module

© 2021 BEI Electronics LLC
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1.5

Editing and navigation

Menu navigation and parameters editing is done by the front panel knob.
On the main menu which appears after firmware boot, is possible to select the submenu for the
various settings.

DMPX Coderx
Audio Input

ID: STATION NAME

Pressing the knob, will enter the selected submenu.

Once entered in the desired sub-menu, if there are adjustable parameters, you can proceed to
editing

HE Set Input :Digital

Analog lev: @ dB
Dig. lev: B.8 dB
Net lev: ©.8 dB

Pressing the knob, an asterisk "*" will appear next to the first editable element. This will not happen
if, on the current window, there are no editable parameters.

HESet Input:Digital =*
Analog lev:
Dig. lev:
Net lev:

Turn the knob to position the "*" cursor on the other editable elements of the current window.

HES=t Input :Digital
Analog lev: © % dB
Dig. lev: ©8.8 dB

Net lev: B.8 dB

If you want now to change the analog input sensitivity, press the knob again. A "<" symbol will
appear next to the parameter to indicate that this is being edited.

© 2021 BEI Electronics LLC



DMPX Digital stereo coder

HES=t Input :Digital
Analog lev: B < dB

Dig. lev: ©.8 dB
Net lev: B.8 dB

Turning the knob, you now will modify the selected parameter's value.

HES=t Input :Digital
Analog lev: -6 { dB
Dig. lev: ©.28 dB
Net lev: B.@ dB

Once set the desired value, press the knob again. The cursor will switch to "*" again, indicating that
items navigation mode is now active and other items can be selected and edited as described
before.

HE =t Input :Digital
Analog lev: -6 ¥ dB
Dig. lev: B.@ dB
Net lev: ©0.@8 dB

If editing is however terminated, press the knob again and the "*" cursor will disappear and you can
rotate the knob to navigate to other windows.

HESet Input :Digital
Analog lev: -6 dB
Dig. lev: B.8@ dB
Net lev: ©.8 dB

Inside any submenu, pressing the knob for more than 3 seconds, will cause a jump to the main
menu.

DMPX Coderx
Audio Input

ID: STATION NAME

© 2021 BEI Electronics LLC
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2.1

211

2.1.2

Front panel display

Following are listed all menus and functionalities available on the current firmware release.

RDS Coder

DMPx Coderx
RDS Generator

ID: STATION NAME

Into this section are comprised all functions and menus related to the optional RDS encoder.
RDS level and flags

RDS: ON LEV:3.0 KHz
TP: OFF TA:QOFF RT:OFF

MS:MUS COMPR: ON AH:OFF

RDS(ON/OFF): sets the coder on and off.

LEV: RDS subcarrrier level

TP (ON/OFF): sets the TP flag status

TA (ON/OFF): sets the TA flag status

RT (ON/OFF): radiotext enable

MS (MUS/SPC): sets the MUSIC/SPEECH flag status

COMPR (ON/OFF): sets "COMPRESSED" flag status

ARTIFICIAL HEAD (ON/OFF): sets "ARTIFICIAL HEAD" flag status

The "mono/stereo” flag is switched automatically, depending on the MPX modulation type selected.

Pl, PTY and AudioMuteRDS

PI:5330
PTY: @9 Varied

AudioMut eRDS: ON

SAVE

Pl: Pl code setting

PTY: Program Type, settings

AudioMuteRDS: when enabled, it turns off the RDS encoder when audio input is muted. This to
prevent receivers to tune on a muted frequency when the same area is already covered by other
repeaters. The mute timeout, AImTime, can be set into the Fallback page. When the RDS encoder
is switched off because of audio mute, the front panel RDS green led will be blinking.

Changes will tak e effect once saved.

© 2021 BEI Electronics LLC



Front panel display 11

2.1.3

2.14

2.15

PS and Radiotext monitor

PS MON iMY RADIO |
RT MON My Radio My best

radio in town

PS MON: Program Station Name actually on air.

RT MON: Radiotext actually on air.

If the Radiotext Plus is active for the currently aired Radiotext string, a "+" symbol will be appended
to the "RT" label.

Radiotext Plus, Dynamic PSN and CT (clock time) functions are available using the supplied
software RD-Link

PS Editor

PS 1 :MY RADIO

Dur(secs): 2 SAVE DEL

In this window you can enter and edit PS strings that will be displayed by the receiver, each of which
can be up to 8 characters long.

PS 1..24: selection of the item to edit.
Dur (secs): display time, in seconds, of the currently selected string . A duration of zero, will disable
the display of the string.

SAVE: Sawe the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

RT Editor

RT 2<{:My Radio My best
radio in town

Durimins): 1 SAVE DEL

In this window you can enter and edit RT strings that will be displayed by the receiver, each of which
can be up to 8 characters long.

RT 1..24: selection of the item to edit.
Dur (mins): display time, in minutes, of the currently selected string . A duration of zero, will disable
the display of the string.

© 2021 BEI Electronics LLC
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2.1.6

SAVE: Sawe the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

AF list Editor

AfList: 1 Fregs:14
Freqg #: 1 181.0©

Freq INSERT DELETE
List SAVE CLEAR

Alternative frequencies editing window .It is possible to insert up to 25 frequencies on the first list for
the method "A", or 24 lists for method "B". For more details on the differences between the A and B
modes, please refer to the AE List window of programming software.

AfList 1 ... 24: selection of the AF list to be edited.

Freqs: indication of the number of frequencies into the selected list.

Freq #: selection of the frequency number in the list, from 1 to 25, to be edited.

Freq INSERT: Insert a new frequency in the "Freq #" position. The other frequencies in the list will
be shifted accordingly.

Freq DELETE: the current frequency will be deleted.

List SAVE: sawes the changes

List CLEAR: deletes all frequencies in the current list

Notes:

The list, once modified, will be used only after it has been saved using the SAVE button. Selecting
a different list (AfList) or exiting the editing window before saving the list, will result in losing all
changes.

Any empty frequencies (--.-) eventually contained into the list, will be deleted automatically upon
saving.

© 2021 BEI Electronics LLC
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2.2 Audio input setup

DMPx Coderx
Audio Input

ID: STATION NAME

In this section are present all controls related to audio sources and automatic audio fallback

2.2.1 Audio levels monitor and input level setting

Input:DIG Gain: ©.80 dB

-24 -18 -1Z L

The bars are showing the input signal peak level: the input level must be adjusted to have the reading
peaking around 0dB. The single bar below shows, with a long decay time constant, the
instantaneous clipping level of the input signal. Short peaks up to +3dB are quite normal, expecially
when the input signal, despite it was already compressed - limited by a suitable FM broadcasting
processor, is then transferred through MPEG compression.

It is possible to adjust the clipping threshold threshold in the "Preemphasis Limiter and Clipper"
menus.

The input level of the selected channel can be adjusted, but the channel will not be put on air.
To change the on air input channel, the following window must be used.

2.2.2 Audio source setup

Audio input:  Analog, analog input
Digital, AES/EBU input
NetAudio, streaming audio input.

Analog lev: audio input attenuator level. This adjustment sets the input level to the A / D converter.
The nominal level is indicated in the bars:

Set Input :Digital
Analog lev: 9.8 dB

Dig. lev: 0.0 dB
Net lev: .80 dB

The initial adjustment of the input level should be made so that the maximum analog input level is
equal to or only slightly abowe that limit.
In no case the front panel "CLIP" led should light.

Dig. lev: AES/EBU level adjustment
Net lev: streaming module lewvel adjustment.

© 2021 BEI Electronics LLC
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2.2.3

The adjustment of the individual channels is in 0.1dB steps.

Audio fallback setup (audio backup)

The processor can be set to automatically switch to an auxiliary input source if the main input audio
level is below a minimum threshold.

Fal lback:0FF OnAir:DIG
x [1:ANA AlmTime : 30

o [12:DIG BackTime: 120
o I3:NET AlmThr: -680 dB

Fallback (ON/OFF): Enable / Disable automatic audio fallback on backup source.

OnAir: audio source actually on air

11 - 12 - 13: Channel list. The channel are listed by order of priority, with maximum priority assigned
to channel 1.

When an high priority channel will become unavailable, it will be replaced by a lower priority one until
its recovery.

AlmTime: Alarm timeout

Back Time: Back timeout. It is the time for which the main audio source must be abowe the
minimum threshold before it can be set back on air.

AImThr: minimum audio level threshold

The main audio source is considered valid If the level of both channels L / R are abowve the alarm
threshold. If a single channel is less than the alarm threshold for a period longer than the alarm
timeout, the backup source will be put on air.

When the main audio source will recover, once elapsed the "Back Timeout", it will be put back on
air.

Changes will be applied upon exiting the menu.

© 2021 BEI Electronics LLC
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2.3 Audio output setup

DMPx Coderx
Audio Output

ID: STATION NAME

This section contains the settings relating to the DIG OUT - L R OUT audio outputs (only if the
optional outputs are present).

2.3.1 Audio output regulation

ANA Out lev
DIG Out lewv

0.0 dBu
-6.0 dBFS
SEUS

QUT deemph :
Qut pos: Post clipé&Filt

ANA LR Out : audio output level on rear XLR Left-Right OUT connector.
DIG LR Out : output audio level on rear XLR DIG OUT connector
Out deemph: output audio deemphasis. This is related only to the audio output, not to MPX output.
Out pos: point of acquisition of the output signal, it can be selected form:
Post clip&flt: output signal is taken after clipper and lowpass filter.
Pre filter: output signal is taken prior the lowpass filter, but after the clipper.
Pre clipper: output signal is taken before the clipper.

2.4 MPXoutput setup

DMPx Coderx
MPXx Output

ID: STATION NAME

24.1 MPX modulation and pilot subcarrier setup

Modulation : Stereo
Preemphasis: Sbus
: 5.0 KHz

Pilot Level
Pilot Phase: 8.00 Deg

Modulation (stereo, mono I+r, mono L, mono R):
Stereo: stereo modulation
Mono L+R: monoaural modulation from L+R channels sum.
Mono L, Mono R:monoaural modulation from a single channel.
Preemphasis: 50/75uS preemphasis, it should be set according to local FM broadcasting

© 2021 BEI Electronics LLC
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242

standards.
Pilot level: 19KHz pilot tone injection level.
Pilot Phase: pilot tone phase adjustment.

Output level setup

Audio level : 89 b4
Composite lev: 0.8 dBu

Test Tone (1Y):0FF

Audio level: percentage of audio signal (L+R, L-R) into the composite MPX signal.

In case of monoaural broadcasting, without RDS and pilot subcarrier, this level can be left at 100%,
and this will produce a deviation of 75KHz.

In all other cases it should be reduced according to the lewel of injection of the two subcarriers,
otherwise overmodulation will occur.

For example, if a RDS subcarrier of 2KHz and a pilot tone of 6KHz are desired, the audio signal lewel
can not be greater than

100*(1- ((PilotCarrierDeviation+RDSCarrierDeviation)/75))
which, for the example described above, will correspond to:
100*(1- ((6+2)/75))=89.3%

Composite level: MPX output level.

Test tone (!): when activated, will put on air a 400Hz tone, having an amplitude equal to 100%
modulation.

If RDS and pilot subcarriers were correctly set, the final modulation will not go abowve this limit.

© 2021 BEI Electronics LLC
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243

2.5

251

252

Preemphasis Limiter and Clipper

Preemph Limiter: OFF
Qutput CLiplev : 9.1 dB

Preemph limiter: enables a preemphasis limiter to prevent sibiliance splatter when the input
material was not already processed through a processor expressely designed for FM broadcasting.
Clip level: adjustment of audio clipping threshold referred to 0dB.

System setup

DMPX Coderx
System

ID: STATION NAME

Display, Source Dependent Presets, Device ID

Contrast: 16

ID: STATION NAME

Contrast: display contrast adjustment.

ID: device identifier. It is a 16 characters long label which will be shown in the main menu screen,
useful for identification when multiple devices are installed.

GPland MPX changeover option (Split)

76543210
GPI status : DRRDID

Split ctrl port:0OFF
Invert split status:0FF

In this menu it is possible to remotely select the channel to be broadcast or manage an MPX
adwertising split in output (option). The election is possible via GPI, serial and Network card.

GPI status: status of the 8 available ports, from 7 to 0.
Split ctrl port: enable the function and select the communication mode.

OFF: disabled function.
GPI: active function on CTRL port.

© 2021 BEI Electronics LLC
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Serial: active function on RS-232 port.
Network: active function on Ethernet port.

Invert split status: invert commutation MPX Input set on GPl mode
OFF: without command it is set in [NETWORK] mode.
ON: without command it is set in [SPLITTING] mode.

The split status is shown at the top of the display.

In [SPLITTING] mode, in MPX output there is the processed signal coming from Analog or Digital
Inputs or Net Ip stream (if present).

In [INETWORK] mode, in MPX output, the signal applied to MPXIN is present.

Rear Connectro GPI (CTRL)

GPI port status:

: Pin 6 - Set ANALOG Input

: Pin 2 - Set DIGITAL Input

Pin 7 - Set NET/IP Input

Pin 3 - Set MPX Input (SPLIT)
Pin 8 - Not used

Pin 4 - Not used

Pin 9 - Not used

: Pin 5 - Not used

NoahRhRwNhMROQ

DB9M

Not Used e
Not Used - (@& 4 (9 Not Used

Not Used
Set MPX Input (SPLIT)- 83 © orrse

Set NET/IP Input
Set DIGITAL Input -8 2 g Set ANALOG Input
GND

The inputs are activated by grounding the relative pin or by providing a wltage from 5 to 12VDC, in
this case the jumpers placed on the board inside the device will have to be moved from the "CLOSE"
to "VIN" position.

The selection of the channels through the GPI port takes place with exclusive priority on a single
channel, if more inputs are activated at the same time the channel is restored before the selection,
only the MPX channel has absolute priority and at each activation it does not take into account the
status of the other 3 inputs by bringing the MPXIN signal to MPX OUT.

Example 1: the Analog channel is on the air, pin 2 is activated by broadcasting the Digital channel,
at the same time pin 7 NET / IP is also activated, since the selection of two channels is not valid at
the same time, the channel returns to air Analog.

Example 2: the Digital channel is on the air, pin 6 is activated by broadcasting the Analog channel,
at the same time the MPX pin 3 is activated, the analog channel remains active but the MPX output
is switched to MPXIN.

© 2021 BEI Electronics LLC
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Network command by lan:
By selecting Network on "Split ctrl port" commands can be sent via LAN using the UDP protocol
with standard ethernet card, the TCP protocol with IP Streaming option card.

[AB010103] select analog input

[AB010200] select digital input

[AB010301] select NET/IP input

[AB010406] / [AA010001] select MPX input
[AB010002] o [AA010100] return on main channel

The selection command must be repeated continuously otherwise the device re-enters the main
channel.

253 PassCode Setup

User Password: 1% %1%
Autologout (mins): 3

LOGOUT SAVE

User Password: in this section the user can enter a numeric password that will be required for
accessing the device. Setting "0000" (default value) will disable the password prompt.

Autologout (mins): Automatic lock timeout. If no action is done on the front panel knob within the
specified time interval, the device will enter into lock state and the user will need to re-enter the
password to log in again.

LOGOUT: immediate logout and lock.

SAVE: Sawes any changes made to the numeric password or the duration of the automatic logout
timing.

2.5.4 Ethernet setup

IP : 192 168
GWY : g © © 0

Port : 548000
NetMask: 24

IP: current ip address

GWY: gateway address

Port: UDP port number

NetMask: netmask in CIDR notation.
APPLY: apply and save changes.

This page is visible only if the network module is installed.
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255

25.6

2.5.7

System info

Sys
Proc:

Sys: operating firmware release

Proc: audio processor and MPX coder firmware release
Hw: hardware release

BL: MCU bootloader release

SN: serial number

Options

PURCHASED OPTIONS
%5 6150 510 50,5 %1% 5 510 515 5 G5

ENTER

In this window the user must enter the code to enable the optional features.

Once entered the code for the desired option, go to the "ENTER" button and, when it will flash, push
the front panel encoder.

The device will verify the code and, if found correct, will activate the requested option.

Example for RDS coder:

OPTIONS
% % %1% % %1% 1% % % % % %)% % %))
[RDS]

ENTER

Login window

To protect the device from unauthorized operation, a security code can be enabled by accessing the
System menu, Set password.

When the device is turned on (or the auto logout time is elapsed), the login page will be shown
where the pass code is to be entered.

Passcode

%5 51%) LOGIN

LOGIN: when the correct pass code is entered, will log in user.
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Pass code lost or forgotten: after the 20th unsuccessful login attempt, an unlock code will be
displayed.Call customer senice and tell this code in order to get back your pass code.

Passcode

Unlock 33@DB3

%5505 LOGIN

© 2021 BEI Electronics LLC
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3.1

Programmming software

A PC based softwareProcessor Programmer, compatible with 32 and 64 bits Windows Xp, Windows
7, Windows 8.X, Windows 10, is provided for processor remote control and setup.

Connection is done through:

e serial port 9600 baud 8N1

e ethernet port TCP-IP (if optional streaming module is installed)
e ethernet port UDP

Main window

In the main window the type of connection can be selected, via COM port or through Ethernet port
using TCP-IP (needs streaming module) or UDP (needs ethernet module). Once the communication
mode is set up and the processor connected, press "Connect". If communication is correct, the
program will read all internal settings and device information.

WP Processor Programmer

PassCode Processor System
Connection
Comm Interface

® Serial TCP-IP

Serial port:  COM1:Porta di comunicazione (COM Disconneck

Gek Info

Comm Interface
Serial & TCP-IP upe
1419000500 In: 192 . 168

Port: S4000 =

Comen Inkerface
Serial * LDP

192 . 168 . . 51 Disconnect

-

53000 =
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3.2 Audio/System

This section contains the audio process controls, setting of the audio input and output sources and
system parameters.

3.2.1 Audio input-output

This page allows for selection of on air audio input, changing audio output parameters, setting up the
audio fallback.

AUDIO Input-Output
Audio Input  Analog input
Analog In Level dB 0,0

Digital In Level dB 0,0

2 MetworkInlevelds 6,0 T Analog Qutput Mode Clipped and filtered
§ AnzlogOutleveldB 0,0 3 Analog Output Deemphasis 50uS
* AES Out Level dB 5,0

30 Input 30Hz HPF

16 Audio Eial:kup Enabled \/

Metwork: Alarm Timeout (5)
AES EBU .
Analog input e

Network , MPX Input ~ Alarm Thresheld (dE)

Update

For a detailed description of the following parameters, please refer to audio input setup, audio output
setup.

Audio Input
Analog InputLevel

Digital InputLevel
Network InputLevel
Audio OutputLevel
Audio Backup Enalbled

Read: read parameters from the processor
Update: send changes to the processor
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3.2.2

System setup

In this page it is possible to enable and adjust the optional RDS encoder carrier level, the pilot
carrier, insert and adjust the network parameters.

System

RDS Enabled v
NET IP

RDS Level KHz 2,0 192

Pilot Level KHz 6,0 NET MASK

2 7
Filot Phase # 0,00 =2 . &8

MNET GATEWAY

2 . e
reemphasis S0us
MNET PORT 54000
MP¥ Out Level dB 0,0

30 Mpx Audio Level % 100

Cut Clip leve

Nebtwork Preemphasis Limiter

read Update

The network parameters are related to the optional network module only. If the streaming module
was installed, network configuration will be done through the web server of the module.

For a detailed description of the following pararmeters, please refer to MPX output setup and System
setup

RDS_Enabled, RDS level, Pilot Level, Pilot Phase, Modulation, Preemphasis, MPX Output Level,
MPX Audio Level

NET IP, NET MASK, NET GATEWAY, NET PORT

Read: read parameters from the processor
Update: send changes to the processor
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3.3 Loading and saving system

The remote control software allows to load and save the system configuration through the "System"
menu, and this includes all parameters listed under "System" and "Audio Input-Output" tabs.

Save System config to Disk

Load Systern Configuration

Save System Ceonfiguration

Salvain | Audio Processor j I‘j‘ E~
|-_._ Mome = Tipo Dimensione
b - -
Risorse recenti | System conf!g mod.dprobsys F!Ia DPROGSYS 2KB
| System config.dprobsys File DPROGSYS 2KB
Desktop
Raccolte
LY
Computer
= %
“w
Rete
4 T | +
Mome file: |System corfig mod.dproGeys j Salva |
Salva come |DPROBSYS Files j Annulla

the system configurationi will be saved to disk.

Load System config from Disk

Load System Configuration

ave System Configuration

Cerca in: | Audio Processor j £ B
= Mome = Tipo Dimensione
s
=¥ [ 5ystem config mod.dprofisys File DPROGSYS 2KB
Risorse recenti - -
|| System config.dprobsys File DPROGSYS 2KB
Deskiop
Raccolte
L "
Computer
e J
A
Rete
4 1 | [*
MNome file: |Sy5tem corffig dpro6ays j Apri |
Tipo file: [DPROBSYS Fies =] Annula

the system config preset loaded in.
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3.4

34.1

RDS

RDS configuration pages will be visible only if the optional RDS coder was enabled.

RDS Flags window

Connection RDS Generator
Flags
Current Page

Station ID  STATION NAME
Read

Program Ty Country Coverage

Write

Music
Artificial Head

Compressed

Enable Radiotext

Switch off RDS on audio mute All RDS paramete

Coder
Program Coder

Abort

This window contains the configuration parameters of the RDS encoder.
RDS ENABLED: enable RDS coder.

PTY: Program Type

Set the program type.

Many receivers are equipped to select the received stations based on the format preferred by the
listener.

Pl:Program Identification

Identification code of the station.

The code consists of 4 digits, the first digit indicates the country of origin, the second represents the
area of coverage and the last two identify the station into its coverage area.

First digit, the country of origin of the program. You may write it directly into the “Pl Code” editbox or
select it using the “Country” dropdown list.
A list of some country codes is reported in appendix A.

For the second, according to the coverage area, choose one of the following codes:

0 local cowverage, the station is supposed to have one frequency only
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International coverage

National coverage

1

2

3 Supra-regional coverage
4.

F area codes for regional coverage stations

Note: the local coverage code “0” is intended for stations having one_frequency only, so its use is
intended just in this case. If the station has more than one frequency, a supra regional (3) or
regional code (4 to F) must be used.Using the local coverage code (0), make many receivers to
ignore the alternative frequencies tables.

The two last digits uniquely identify the station into its coverage area and shall be different amongst
all other stations broadcasting over the same area.

Some examples:

5001.: Italian radio station (5) local coverage (0, program identifier code 01
5202: Italian radio station (5) national coverage (2), program identifier code 02
B54AF: ltalian radio station (5) regional coverage (4, program identifier code AF

TP: Traffic program
This flag indicates that your station, during normal programming, broadcasts traffic programs.

TA: Traffic Annonunce

Traffic Announce on air.

This flag should be set when traffic related news are being broadcasted.
For this reason, the TA flag can be switched by the external control port.

MUSIC: This flag indicates if the station main format is music or speech.

Some receivers use this information to apply a different tone equalization or wlume according to
whether music or speech is being broadcasted.

It is possible to switch this flag externally, using the external control port.

ARTIFICIAL HEAD:This flag indicates that the program was recorded using an artificial head.

This device is a dummy human head with two microphones inserted into the auditory canals, used
during the recording process of the performance or live event, to accurately reproduce the original
spatiality.

COMPRESSED: This flag indicates that the program was compressed.

ENABLE RADIOTEXT:Flag to enable radiotext group (2A) transmission.
If disabled, only OA groups will be trasmitted.

SWITCH OFF RDS on AUDIO MUTE: enabling RDS coding to be turned off in the absence of
outgoing audio. This awoids the possibility of tuning into a mute frequency, the RDS off function is
traced with the flashing of the green LED on the front of the device.

STATION ID:This 16-chars string can be assigned to the coder for its identification.

It could be its destination, the site to which the encoder is assigned, or the name of the radio which
owns it.

It will not be shown anywhere else, neither transmitted into any RDS block; it is only a label to
identify the processor.
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3.4.2 PSwindow

Conneckion RDS Generakaor

PS

PS Duration {secs) Current Page

MYRADIO
Read

Modified

Program Coder

Abort

o oo o o o o o o o o o o o o o oo B

In this window, It is possible to enter the program station names, each of which can be up to 8
characters long.

For each string you can set the display duration time in seconds.

A duration time of 0, disables the corresponding string.

READ: read all PS strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified entries
CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.
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3.4.3 Radiotext window

RDS Generakaor

RadioText Duration {mins}) Current Page

My Radio, best skakion in bovn 1

Read

¥es, it is really the best

Modified

Program Coder

Abort

In this window, It is possible to enter the radiotext strings, each of which can be up to 64 characters
long.

For each string you can set the display duration time in minutes.

A duration time of 0, disables the corresponding string.

READ: read all radiotext strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified Radiotext entries
CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.

© 2021 BEI Electronics LLC



32 DMPX Digital stereo coder

344 AF Lists window

Flags AFList
Freg Info I aflist 1 E Current Page
AF 1 101.0 —
. Read

AF 2 104.4 Aflist2
AF 3 104.5 Af list3
AF 4

Af list4
AF 5
AF B Af list5
AF 7

Af list6
AF &
AF 9 Af list7
AF 10 Clear all

Af list 8
AF 11 all RDS parameters
AF 12 Af listg

Read Coder
LA Af list 10
AF 14 P Zod
ogran Coder

AF 15 Aflist 11 i
AF 16 Af list 12 Abort
AF 17
e w || &f list 13

The RDS encoder allows for method "A" or "B" for alternative frequencies coding.

The choice between the two methods depends on the structure of the network and the number of
alternative frequencies.

There is no flag which indicates if the alternative frequencies are transmitted by method "A" or "B":
the difference between the two methods is encoded in the way the frequencies are disposed into the
list.

Notes:

It is not possible to compile different lists using the A and B simultaneously.

“A” method should be used only when the network has a maximum of 25 frequencies and does not
differentiate regional programming.

“B” method is used when the alternative frequencies are more than 25 or when, within the same
network, there is a program differentiation, such as local news or advertising, only on certain
frequencies.

The lists must be compiled starting from the first and should be filled leaving no empty lists in
between: any empty list will be automatically removed upon coder programming.
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3.4.4.1 Editing

Clear lisk

Sort Frequencies
Build B List
Insert

Rermone

Af list1

33

Current Page

Af list2

Read

Af list3

w'rike

Af list4

Af list5

Af list6

Af list 7

Clear all

Af list8

all RDS parameters

Af listg

Af list 10

Af list 11

Program Coder

Af list 12

Abort

Af list 13

The frequencies must be inserted starting from the first list “Af list 1", cell AF1.

Right-clicking on the list, a popup menu will appear allowing to:

Clear list: the current list will be cleared

Sort frequencies: the frequencies inserted into the current list will be sorted in ascending order
Insert: insert a new frequency at the selected cell position

Remove: remowve the frequency at the selected cell position
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3.4.4.2

3.4.4.3

A Method

This is the simplest method and it is indicated for all those stations which have a maximum of 25
alternative frequencies and do not provide regional - differentiated programming.

To implement this method, simply insert in AF List 1 all frequencies of the station in ascending
order.
No other list must be filled.

Example:
88.1

91.3
104.1
104.5

B Method

This method is used where the number of alternative frequencies used in a network exceeds 25, or
where it is required to indicate frequencies which belong to different areas which at times carry
different programs.

Each transmitter and associated repeater stations broadcast the same set of different AF lists in
sequence.

The number of AF lists within a network is in general identical to the number of transmitters and
repeater stations in the network so as to provide a unique list for each transmitting station. In this
protocol the alternative frequencies for the VHF/FM transmitters are individually addressed by
transmitting the tuning frequency paired with one alternative frequency within one block.

Each list starts with the tuning frequency for which the list is valid.

All remaining pairs (up to 12) give the tuning frequency together with a valid AF.

Usually, the tuning/AF pair has to be entered in ascending order if the AF is not a regional variant of
the tuning frequency, on the contrary the order has to be reversed.

If the number of AFs of a station is larger than 12, the list must be split into two or more lists. These
lists are transmitted directly one after the other, and the receiver must combine the lists again.

If a transmitter frequency is used more than once within a network the respective AF lists are
transmitted separately. In order to indicate that these lists with the same tuning frequency belong to
different stations, the lists must be separated by AF lists of other stations.

To simplify the programming of a B list, put into the first line AF1 the main tuning frequency, then
enter on the other lines (AF2 to AF13) a maximum of 12 alternative frequencies, then press the
button "Build B list.”

If you, in future, wish to add some new frequencies to the list, simply enter them at the bottom and
press the button "Build B list again.”
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Current Page

& Current

Abork

Freq Info | aflist 1
AF 1 90.0 =
AF 2 1045 Af list2
AF 3 93.5 Af list3
AF 4 105.2
Af list4
AF 5 106.7
AF 6 1049 Af list5
AF 7
Af list6
AF 8
AF 9 AF list7
AF 10 .
Af list 8
AF 11
AF 12 Af list9
T Af list 10
AF 14
T Af list11
AF 16 Af list 12
AF 17
w || &f list 13

The main frequency (90.0MHz) is put in the first AF cell (AF1) and all alternatives are following from

AF2 to AF6.
Flags
Freq Info

AF 1 Q0.0 Main Freq
AF 2 Q0.0 Main Freq
AF 3 93.5
AF 4 Q0.0 Main Freq
AF 5 104.5
AF b 90,0 Main Freq
AF 7 104.9
AF 8 Q0.0 Main Freq
AF 9 105.2
AF 10 Q0.0 Main Freq
AF 11 106.7
AF 12
AF 13
AF 14
AF 15
AF 16
AF 17
L I |

W

Af list1

Current Page

Af list2

Af list 3

Af list4

Af list5

Af list6

Af list7

Af list8

Af list 9

Af list 10

Af list 11

Program Coder

Af list 12

Abort

Af list 13

Right click on the list and select the “Build B List” command: the list will be compiled using "B"

method.
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3.4.5 Loading and saving RDS coder configuration

The remote control software allows to save and reload a complete RDS coder configuration through
the File>RDS menu:

Load Configuration

Load Configuration

Configuration

Cercain | 23 Ust Presets v| €] 5 S
) Rds 02_2015 rds
{ Rds 10_27014 rds
Documenti Rds Stationl .rds
recenti Rds Station2.rds
=
L
Desktop
Drocumenti
Risorse del
computer
" Marme file: V| I Apri I
Risorse direte | Tipo file: |F|DS Files v | [ Annulla ]

Save Configuration

Salva con nome

Salvain | 23 Ust Presets v | O E-
Y Rels 02_2015.rds
i Rds 10_2014 rds
Documenti Rds Stationl .rds
recenti Rds Stationz.rds
=
L
Desktap
Drocumenti
Risorse del
computer
" Mome file: F:d::: ( = | I Salva I
Risorse direte | Salva come: |F|DS Files - | [ Annulla ]

The *.rds file will contain the whole RDS encoder configuration, it can be stored as a backup or used
to transfer the configuration to other devices.
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3.5 Passcode setup

MultiBand Processor Programmer Ver,

e Processor

Change Pa

Store PassCode to disk

Serial

192

54000

Get Info

Disconnect

To protect the device from unauthorized operation, a security code can be set. The default code is
0000 (security disabled), but it can be changed through the following procedure:

Put the current Passcode into the PassCode edit box (0000 by default).
Put a new code into the "New Code" and, the same again, into the "New Code Confirm" editor.
Go to Menu->PassCode->Change Passcode

Warning

The user will be prompted for passcode change confirmation, then the passcode will be changed.

x

r] This precedure will change your current pass code,

Really continue?
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4 RD Link

RD-Link is a software which allows the connection of the RDS coder to the radio automation system
to allow for dynamic radiotext and radiotext Plus, TA and Clock-Time to be implemented.

At the time of writing this document, the software is already compatible with sewveral radio
automation systems, but other interfaces may be included on customer request in order to extend

the compatibility to other systems.

¥ RD-Link ¥:2.0.0.0 Raw text =13

File Tools

Filetame: C:\Documents and SettingsiItelDeskiophRT+Hbest, bk

Arkisk
SHAKIRA

a Tartura

03/03/15 09,40.41 RT+:5HAKIRA La Tortura

4.1 Radiotext Plus
Radio text plus is a complementary senice that, united with classic radiotext, enables tagging of
specific radiotext parts so that they can be isolated and used by some specialized receivers.
You can then, for example, have the complete station playlist aired for the listening period.

An example of normal radiotext tagged with radiotext plus (RT+).

The normal radiotext carries the string: "SHAKIRA - La tortura"
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A receiver with Radiotext Plus decoding capabilities will "know", for example, which part of the whole
text is the artist's name and which is the song title.

In this case, the song title and artist's name are used to compile the playlist aired by the station we
are listening.

In the case below, the radiotext string is "You are listening to Shakira with La tortura Feat. Alejandro
Sanz" and both normal radiotext and tagged radiotext are shown: first string is the artist name, the
second is the song title, last string is the normal radiotext.
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SHAKIRR
L tortors Feat Ko
tou ars lsbening 15 BHNEI

..i..-

4.2 Monitor

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Monitor

iIIS,I'DSII'IS 09,4955 RT+:5HAKIRA La tortura

On the Monitor window the dynamic PS and Radiotext strings are shown in the same way as they
are being transmitted.
It is shown also the status of TA,CT, RT+ flags and scheduler.

TA Orange : TA flag active during traffic news on air.
Gray: TA flag disabled

CT Green: transmission of Clock/Time block 4A, for remote clock visualization and
synchronization, is enabled
Gray: CT is disabled.
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RT+ Blue: the radiotext string actually shown is tagged using radiotext plus.
Gray: Radiotext Plus is disabled.
SCHED Green:scheduler is enabled, Radiotext Plus is enabled

Red:scheduler is enabled, but actually Radiotext Plus is

disabled by the scheduler

Gray: scheduler disabled, Radiotext plus tagging is controlled

by the flag Enable RT
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4.3

43.1

43.1.1

4.3.1.2

Configuration

Open configuration menu (Tools->Configuration), and the following window will appear:

I o duraton

stai ascolkando
B [ addoffset w0 o

o

Setup

Program ID

It is possible to assign a name to the executable window in order to recognize it quickly, when
multiple executables are running at the same time to control different coders (eg different programs
belonging to the same publishing group).

Radiotext Plus and dynamic PSN

Enable RT +: Enable radiotext plus

The strings sent by radio automation system will be passed to radiotext only if this flag is enabled.
You can also add a prefix and a separator to the string which will be put on-air.

Please note that the maximum length of radiotext string in block 2A, is 64 characters.

If the total length of the string, including prefix and separator, will be longer than this limit, it will be
truncated automatically.

Send RT + titles to PSN: Enable sending radiotext titles on PSN.

With this function, the song titles will also be sent on the PSN (maximum length is 8 characters ).
This function should be used with caution as it can cause driver distraction and in some countries is
expressly prohibited. You are advised to check your local regulations before to activate it.
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4.3.1.3

To limit driver distraction, single character scrolling has been reduced to a minimum, as the program
tries to conwey mainly whole 8 characters blocks.

Separator: separator to be inserted between title and artist. A different separator can be chosen
with respect the one used for radio text.

Scroll interval (secs): scroll time interval of a single character.
All strings which will not fit 8 characters, will be displayed by scrolling one character at a time using
this interval.

Word interval (secs): display time of a single word.
A word which has a length less than or equal to 8 characters, will be displayed for the time selected.

Repeat delay (secs): The title will be displayed again on the PSN , after this time (in seconds) is
elapsed. If the entered value is 0, the title will be displayed once at the beginning of the new song,
then the coder will send the PSN strings stored internally until the next song.

End title blank duration (secs): if set to any value other than 0, an empty PSN will be displayed for
the selected duration, once the dynamic PSN is ended and before to putting on-air the internal PSN
strings.

Sync start DyPSN: if enabled, it will start the dynamic PSN only at the end of the internally stored
strings.

Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).

Without Sync Start: "MY RADIO", "BEATLES", "HELP","THE BEST","IN TOWN","MY RADIO",
"THE BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).

With Sync Start: "MY RADIO","THE BEST","IN TOWN","BEATLES", "HELP","MY RADIO","THE
BEST","IN TOWN"(loop) (dynamic PS strings are bolded).

Restart from first PSN item after DyPs: if enabled, after a dynamic PSN is transmitted, it will
restart the display of internal strings from the beginning.

Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).

Without restarting: "MY RADIO", "BEATLES", "HELP","THE BEST","IN TOWN","MY RADIO", "THE
BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).

With restarting:: "MY RADIO", "BEATLES", "HELP","MY RADIO", "THE BEST", "IN TOWN"(loop)
(dynamic PS strings are bolded).

TA - Clock time
Enable TA: the TA flag will be switched on during traffic news.

Max duration: maximum traffic news duration. Once this time is elapsed, the TA flag, if it was
previously set on, will be automatically switched off.

TA Trigger string: it is the name, as passed to the program by the radio autiomation system, of the
traffic news audio file. If traffic news are live, this could be the name of the file used as traffic news
liner. The name is case insensitive.

Hide traffic title string on radiotext: if enabled, it will not send the string associated with the traffic
news file to radiotext or PSN.

Enable CT: enable sending CT (clock time).
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4314

Enabling this function, it will be sent the 4A block for radio alarm clocks synchronization and date-
time visualization.

As the PC system clock will be used, it is recommended to keep the system clock synchronized
using any time senver.

The 4A block transmission will be suspended when PC is shut off or the PC-Coder communication
is broken.

Add offset: offset for the time currently sent.

Communication interface and additional settings

Max RT Duration: maximum radiotext duration.

This control sets the maximum time for the same Radiotext Plus string visualization. If this period is
exceeded, the coder will start to send the internally stored RT strings, returning to dynamic RT+
once a new string is received.

Show log: show program activity log.

Center PSN: auto center the strings displayed on PSN, if they are shorter than 8 characters.

Use scheduler for dynamic contents: enable scheduler for dynamic radiotext plus and PSN
activation, if they are supposed to be active only on some week days or at a specified time,

Create a copy of RDS file: creates an identical copy of the title file written by the automation
system to be read by other applications (eg: streaming encoder).

Save log: sawe a daily program activity log on a file eg: "log_18-06-2014.txt"

Coder interface: communication interface selection, RS232, TCP/IP or UDP.
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4.3.2

Raw Text Importer

Raw text importer allows to read plain text files generated by the radio automation system.

La tortura ; SHAKIRA

0y La kortura
1: SHAKIRA

1 4 SHAKIRA
0 4 % | |La tortura
i
o

The contents of the currently selected file (from the main window menu File-> Raw TextFile) is
displayed in the Raw Text Input.

The artist and title fields may be separated in two ways:

using separators: the strings read from the file will be divided using the characters entered in the
"Separators" editor.

In the above example, the input string "SHAKIRA;La tortura” is divided, using the separator *;".

This will produce two output lines (line O:La tortura, line 1: SHAKIRA).

Then, using the controls "Artist item" and "Title item", set which line must be used as title and which
one as the artist name.

using identifiers eventually included in the raw file: if the raw file was already marked with
labels such as:

CurrArtist = Michael Jackson

CurrTitle = Thriller

you can simply enter in the editors "Artist ID" and "Title ID" the two identifiers "CurrArtist =" and
"CurrTitle =" (without quotes).

The program will then automatically isolate strings related to artist name and song title.
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4.3.3

In both cases, pressing the "Test" button, the user will be able to experiment with different settings
of indexes, separators or identifiers.

If the checkbox "Ignore if artist or title are null" is checked, all items having no artist name or title will

be discarded.
This feature, combined with the word filter, avoids to display jingles titles, backing tracks and
everything else that must not appear in the dynamic radiotext.

Word filter

Word filter awids the visualization, on dynamic radiotext and PS, of all strings which match any
word in list.

‘Word Filter

String Mode

Unknown whole Word
Error whole Word
Fault Ay Occurrence

Fault Any Occurrence ~ | Add

Enatle word Filker

Words are added writing them in the editing line, then must be set the recognition method (Whole
Word or Any Occurrence). Pressing the "Add" button, the new word will be added to the list.

Whole word: the word to be recognized must be correspond exactly to the input string:

Example, filter word "apple": "apple" is recognized and filtered, "pineapple" is not recognized.
Any Occurrence: any occurrence of the filter word is recognized:

Example, filter word “"wide": "wide" is recognized and filtered, but also "widescreen" or
"worldwide".

Words are always compared in case-insensitive mode: setting a filter for word "Test", "TEST" or
"TeSt", will result in the same effect.
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4.4 Scheduler

The dynamic content scheduler (menu Tools->Scheduler) allows to activate the Radiotext Plus
and dynamic PSN only in predetermined time intervals.

Scheduler

@ Sun  Mon ¢ ' Tue | Wed  Thu  Fri | Sat

StartTime | 000,00 3 " Enabled

Skark End Stakus
0.00.00 23.59.59 OFF

Update

Same for all days ||| Clear all schedules

For example, we want to use dynamic RT+ and PSN only from 8.00 to 12.00 and from 18.00 to
23.00 every day except on Sundays where it will be active for the entire day.

So an event must be created, scheduled for 8:00 am (set into "Start Time" box), having "Enabled"
status checked .

Pressing the "Add" the button, the event will be added to the events list.

Scheduler
@ Sun  Mon ¢ ' Tue | Wed  Thu  Fri | Sat

StartTime | 500,00 (5 +/ Enabled

Skark End Stakus

0.00.00 §.00,00
8.00.00 23,5959

Same for all days ||| Clear all schedules

We hawe that the dynamic content will be disabled from 00.00 to 8.00 then, for the event we created,
from 8.00 onwards it will be enabled.

Now the dynamic content disabling event should be added: put 12:00 into the "StartTime" box,
unckeck the "Enabled" checkbox and push "Add" button.
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Scheduler

120000 %

End Skakus
5.00.00

12.00.00

23.59.59

The dynamic content has to be re-enabled from 18:00 to 23:00, so one enabling event has to be
added at 18:00 and a disabling event at 23:00.
In the following picture is represented the complete programming.

Scheduler

Skart

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00

23.00.00 23.59.59

Summarizing: firstly the dynamic content enabling was added at 8:00hr, then the disabling event at
12:00hr, the re-enabling at 18:00hr and the disabling at 23:00hr.

Since this scheduling will be the same for almost the whole week, it can be simply copied to the
other days, pressing the "Same for all days" button.
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Once copied, it can be verified that, changing the week day selection at the top of the window, the
scheduling is the same for all days.

Done this, you will then modify the sunday scheduling only, where the dynamic content will be
enabled for the whole day.

Select the week day, on the top of the window, "Sun"

Scheduler

zzo000 3

Same for all days || Clear all schedules

Press the "Clear button" to delete all scheduler entries for the current day.
Once all entries have been deleted, just add an ewvent starting at 00:00, with "Enabled" checkbox
checked to enable the dynamic content .
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Scheduler

Skart
0.00.00 23.99.59

Update

Same for all days || Clear all schedules

Programming is completed. Press "OK" button to save and exit from the current window.
Follows a short description of the other controls on the window:
Remove: removes the currently selected entry

Update: updates the currently selected entry with new time and/or status informations.
Clear all schedules: deletes all entries over all days.
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© 2021 BEI Electronics LLC




Section

Streaming audio module



Streaming audio module 53

5 Streaming audio module

The module adds audio streaming decoding capabilities for receiving streaming HLS / MP3 / AAC +
shoutcast seners by HTTP/HTTPS using TCP / IP connectivity. The module also allows playback of
audio files from an USB key.

The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving
the highest audio quality.

51 Decoder audio Stream

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the login default page.

itel, pstream

No password set by default, click on the login button and enter the main page.

Go to the "Streaming settings" menu and set one or more URLs from which to receive the audio
stream.
Sawe current configuration by pressing the "Apply settings” button.

MENy itel. pstream Help

0 saus Status

=J Streaming settings

Streaming Status

Streaming Status

£+ Network Settings This page displays the status of the

main and backup streams, the URL
Q System Settings of the two streams, the metadata
Main stream:Connected provided by main and backupe

e Open Help http://192.168.1.222:6001 streams, the status of the pre-buffers
expressed as a percentage and
audio levels of on-air source.
http://192.168.1.220:6001 The on-air chain priority is MAIN
STREAM->BACKUP STREAM

Back stream:Connected

(:) System Update

¥ Download finder software

Network Status
5] Logout
On Air stream: This page displays the network
. configurations for the ethernet
http://192.168.1.222:6001 a
interface.
L Level:-0.0dB
u System Status
3% 30 24 a8 12 &6 3 O
R Level:-0.0dB This page shows the status of the
T system and provide info about
30 24 18 12 6 3 0

firmware version, mac addresses,
st lerar (K uptime and global configuration.
o 50 100
System Log
Metadata

Shows the system activity log
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5.2

The module adds audio streaming decoding capabilities for receiving streaming MP3 / AAC + / HLS
shoutcast seners or by using TCP / IP connectivity. The module also allows playback of audio files
from an USB key.

The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving

the highest audio quality.

An helpful guide for all settings appears on the side of the configuration page.

On the audio processor, nhow select the audio input “NetAudio" and the streaming audio received by
the module should be put on-air.

Adjust, if necessary, the input level of audio input "netaudio." If you intend to use any audio
processing during streaming audio playback, this setting can also be omitted since the processor
will provide for automatic leveling.

The preset for the network input can be chosen into the next window, after "netaudio” input has been
selected into the current.

If you want to use more than a single audio source, for using the integrated automatic audio fallback,
proceed to its selection and its associated audio processing preset.

Finally, turn the audio fallback on.

Quick setup

The default IP address is 192.168.1.100.
If the IP is unknown, connect the the processor directly to a PC network card, then use the supplied
utility "module_finder.exe" to recover its IP address.

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the default page.

Go to the "CONFIG" menu and set one or more URLs from which to receive the audio stream.
Save current configuration by pressing the "SAVE & REBOOT" button, wait for the restart of the
module.

Configure the network settings of the module: SETUP -> NETWORK
Sawe by pressing the "SAVE & REBOOT" button, wait for the restart of the module.
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